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Introduction

Target Audience
This guide is designed for system administrators who are planning to administer Adobe® Creative 
Suite® 5 or 5.5 (CS5 or CS5.5) with the Casper Suite.

What’s in This Guide
This guide provides step-by-step instructions for deploying, serializing, reporting on, and updating 
Adobe CS5 or CS5.5 with the Casper Suite.

 
Important Concepts
Administrators using this guide should be familiar with the following Casper Suite-related 
concepts:

•	 Package and script management

•	 Deployment

•	 Licensed software reporting

•	 Application usage reporting

•	 Smart computer groups

 
Additional Resources
For more information on applications, concepts, and processes related to the Casper Suite, 
download the Casper Suite Administrator’s Guide from:

http://jamfsoftware.com/resources/documentation

For more information from Adobe on packaging, deploying, and updating Adobe CS5 and CS5.5, 
download Adobe’s CS5/5.5 Enterprise Deployment Guide from:
 
http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html 
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Overview

The Casper Suite provides a complete solution to administering Adobe products in the enterprise. 
In the past, Mac administrators have used the Casper Suite in combination with the Adobe 
Application Manager Enterprise Edition (AAMEE) to administer Adobe CS5. With the releases 
of Adobe CS5.5 and AAMEE version 2.0 comes the demand for an updated solution. A similar 
workflow can now be used to administer CS5 or CS5.5 using the Casper Suite and AAMEE 2.0.

Using this workflow, administrators can package and provision Adobe CS5 or CS5.5 for 
deployment. They can also automate Adobe’s custom serialization method by deploying the 
Adobe command-line tool along with a serialization script. Coupled with the Casper Suite’s 
reporting capabilities, serialization can help administrators deploy and track product licenses more 
effectively.

Mac administrators also have more options when deploying Adobe CS5 or CS5.5 updates with the 
Casper Suite. In addition to deploying Adobe updates using Adobe’s silent installation technology, 
updates can be installed as they become available by setting up and deploying an internal Adobe 
update server.
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To administer Adobe CS5 or CS5.5 using the instructions in this guide, you need:  

•	 Adobe Application Manager Enterprise Edition (AAMEE) 2.0 for Mac

•	 Adobe Provisioning Toolkit Enterprise Edition for Mac

•	 Adobe CS5 or CS5.5 installer media

•	 The Casper Suite v7.3 or later running in your environment

•	 Access to the JAMF Software Server (JSS)

•	 Casper Admin

•	 Composer

•	 (Optional) A server for the Adobe update server

•	 (Optional) Adobe Update Server Setup Tool (AUSST) 2.0 for Mac

All Adobe Creative Suite deployment tools are available at:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

Requirements
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Deploying Adobe CS5 or CS5.5

This section explains how to deploy Adobe CS5 or CS5.5 with the Casper Suite.

Note: These instructions apply to Adobe CS5 and CS5.5 only. For instructions on how to deploy 
Adobe CS3 or CS4, see the Casper Suite Administrator’s Guide.

Creating a CS5/5.5 Deployment Package
The first step to deploying Adobe CS5 or CS5.5 is to create a deployment package using Adobe’s 
custom enterprise deployment tool, AAMEE 2.0.

Before you begin, review the package creation requirements in Adobe’s CS5/5.5 Enterprise 
Deployment Guide. This guide is available at:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

 
To create a CS5/5.5 deployment package:

1. If you do not have AAMEE 2.0, download it from:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

2. Double-click the Adobe Application Manager folder and open the Install program.

3. Enter the password for a local account and then click OK.

4. Follow the instructions in the “Creating Deployment Packages” section of Adobe’s CS5/CS5.5 
Enterprise Deployment Guide to create the package.

JAMF Software makes the following recommendations:

•	 If you are installing CS5.5, include Acrobat® X Pro in the installation since AAMEE 2.0 supports 
this. If you need to install Acrobat X Pro separately, see the “Administering Adobe Acrobat X 
Pro with the Casper Suite” technical paper for detailed instructions. This paper is available at:

http://www.jamfsoftware.com/resources/white-papers
 

Note: To package Acrobat X Pro using the AAMEE tool, one or more CS5.5 applications must be 
included in the package.
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•	 Configure the deployment package to disable Adobe AIR® components. You can do this on the 
Configure Package pane.

Deployment packages with AIR enabled can only be installed during imaging, from Self 
Service, or with a policy triggered by login. Disabling the AIR components allows you to install 
the package at any time. See the “Installing Products in the Exceptions Folder” section for more 
information about installing AIR separately.

•	 Configure the deployment package to ignore conflicting processes.

You can do this on the Configure Package pane by selecting the Ignore conflicts and continue 
with installation option.

Note: AAMEE 2.0 automatically detects any available updates for the products in the deployment 
package and applies them. This ensures that you are deploying the most up-to-date versions 
of the products. To install an update-only package, refer to the “Updating Adobe CS5 or CS5.5” 
section.

When you are finished creating the deployment package, an AAMEE-created folder that contains 
a Build folder and an Exceptions folder is created in the location where you chose to save it. The 
Build folder contains two PKGs: the deployment package and an uninstall package.

 
Uploading the Deployment Package
After creating the deployment package, upload it to the JSS using Casper Admin. 

 
To upload the deployment package:

1. Open Casper Admin.

2. Log in using credentials for a JSS administrator account.

3. Locate and open the AAMEE-created folder.

4. Open the Build folder and locate the deployment package.

5. Drag the deployment package to the Package pane in Casper Admin.

The package may take a few minutes to upload depending on its size.

6. Double-click the deployment package.

7. In the Information pane that appears, click the Info tab and choose a category from the Category 
pop-up menu.

8. Click the Options tab and choose a priority from the Priority pop-up menu.

The recommended priority for the deployment package is “10” . For more information on priorities, 
see the “Changing Package Attributes” section in the Casper Suite Administrator’s Guide.

9. Configure additional settings as needed and then click OK.

10. Save your changes and quit the application.
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Deploying the Deployment Package
There are several ways to deploy the deployment package: 

•	 Using a policy

•	 Using Casper Remote

•	 During imaging

•	 Using Self Service

This guide includes instructions for the first three methods. For instructions on the Self 
Service method, see the “Making Policies Available in Self Service” section of the Casper Suite 
Administrator’s Guide.

Note: Adobe CS5/5.5 packages that were created using the AAMEE tool cannot be deployed 
using the instructions in this guide if your master distribution point is an SMB share. For more 
information, refer to the following Knowledge Base article:

http://jamfsoftware.com/kb/article.php?id=305

 
To deploy the deployment package using a policy:

1. Log in to the JSS with a web browser.

2. Click the Management tab.

3. Click the Policies link.

4. Click the Create Policy button.

5. Select the Install or uninstall a package option and then click Continue.

6. Follow the onscreen instructions to configure the rest of the policy.

If you chose to leave Adobe AIR components enabled when you created the deployment package, 
you must set the trigger as “login” or “Self Service”.

Computers in the scope execute the policy the next time they check in with the JSS.
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To deploy the deployment package using Casper Remote: 

1. Open Casper Remote.

2. Log in using credentials for a JSS administrator account.

3. On the Computers tab, locate the computers that you want to receive the deployment and select 
the checkbox next to each one.

4. Click the Packages tab.

5. Locate the deployment package in the Packages list and select the checkbox next to it.

6. Click Go to initiate the deployment.

7. When the process is complete, quit the application.

The package is immediately deployed to target computers.

 
To deploy the deployment package during imaging:

1. Open Casper Admin.

2. Log in using credentials for a JSS administrator account.

3. Double-click the deployment package in the repository.

4. In the Information pane that appears, click the Options tab.

5. Select the This package must be installed to the boot volume at imaging time checkbox and 
click OK.

6. Drag the deployment package from the Package pane to a configuration in the sidebar.

7. Save your changes and quit the application.
 
The package is deployed the next time you use the configuration to image computers.
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Installing Products in the Exceptions Folder
Any components that you chose to disable during the creation of the deployment package, such 
as Adobe AIR, are stored in an Exceptions folder. The Exceptions folder is located in the AAMEE-
created folder on the computer that you used to create the deployment package.
After deploying the deployment package, you can install the products that are in the Exceptions 
folder as desired.
 
Installing products in the Exceptions folder involves the following steps:

1. Create an Exceptions folder package.

2. Create the install script(s).

3. Upload the Exceptions folder package and the install script(s) to the JSS.

4. Create a policy to install products that are in the Exceptions folder.

Creating an Exceptions Folder Package

The first step to installing products that are in the Exceptions folder is to create a package of the 
folder using Composer.

 
To create an Exceptions folder package:

1. Create a folder called “AdobeExceptions” in the following location:

/Library/Application Support/JAMF/

2. Move the Exceptions folder from the AAMEE-created folder to the following location:

/Library/Application Support/JAMF/AdobeExceptions/

3. Open Composer and authenticate locally.

4. Drag the Exceptions folder to the Sources list in Composer.
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5. When Composer is finished creating the package source, click the Build as DMG button.

6. When prompted, save the package in the desired location.

7. When Composer is finished building the package, quit the application.

 
Creating the Install Script(s)

Use the commands provided in “Installing Products in the Exceptions Folder” section of the CS5/5.5 
Enterprise Deployment Guide to create an install script for each product that you want to install.

To create an install script:

1. Open a text editor.

2. From the menu bar, navigate to Format > Make Plain Text.

3. Type the deployment commands. For example, if you are installing Adobe AIR, the deployment 
command would look like this:

launchctl bsexec `ps auwwx |grep [l]oginwindow | awk '{ print $2 }'` 
/Library/Application\ Support/JAMF/AdobeExceptions/Exceptions/
Adobe\ AIR\ Installer.app/Contents/MacOS/Adobe\ AIR\ Installer –
silent

4. Save the script as a Bash Shell Script file with the .sh file extension.

5. Quit the application.

 
Uploading the Exceptions Folder Package and the Install Script(s)

After creating both the Exceptions folder package and the install script(s), upload them to the JSS 
using Casper Admin.
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To upload the Exceptions folder package and the install script(s):

1. Open Casper Admin.

2. Log in using credentials for a JSS administrator account.

3. Drag the Exceptions folder package and the install script(s) to the Package pane in Casper Admin.

The package may take a few minutes to upload depending on its size.

4. When the upload is complete, drag the package and script(s) into a category.

5. Double-click the install script.

6. In the Information pane that appears, click the Options tab.

7. Choose “After” from the Priority pop-up menu and then click OK.

8. Repeat steps 5 through 7 for each install script.

9. Save your changes and quit the application.

 
Creating a Policy to Install the Exceptions Folder Package

Use the policy framework to install the Exceptions folder package and run the install script(s) on 
target computers.

 
To create a policy to install the Exceptions folder package:

1. Log in to the JSS with a web browser.

2. Click the Management tab.

3. Click the Policies link.

4. Click the Create Policy button.

5. Select the Install or Uninstall a Package option and then click Continue.

6. Enter the name of the Exceptions folder package and then click Continue.

7. Follow the onscreen instructions to complete the rest of the Policy Assistant.

Set the trigger as “login” or “Self Service” and the execution frequency as “Once Per Computer”.

You will add the install script(s) using the manual policy interface in the next few steps.

8. On the Conclusion pane, verify that the name of the policy is correct and then click Edit Manually.

9. Click the Scripts tab.

10. Click the Add Script link.

11. Select the Run option next to each install script.

12. Click the Add Scripts button.

13. Click the Save button.

Computers in the scope execute the policy the next time they check in with the JSS.
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Serializing Adobe CS5 or CS5.5 

Managing the serialization of Adobe CS5/5.5 products starts with the Adobe Provisioning Toolkit, a 
command-line tool from Adobe. This tool allows you to serialize Adobe CS5/5.5 products after they 
are deployed.

Post-deployment serialization allows you to distribute licenses more effectively by activating only 
the products that a user needs on a given computer.

Serializing Adobe CS5/5.5 products involves the following steps:

1. Create an Adobe Provisioning Toolkit package.

2. Create the serialization script(s).

3. Upload the Adobe Provisioning Toolkit package and the serialization script(s) to the JSS.

4. Create a policy to serialize Adobe CS5/5.5 products.

Note: This workflow is intended for Adobe CS5/5.5 products that were packaged using AAMEE 
2.0.

 
Creating an Adobe Provisioning Toolkit Package
The first step to serializing Adobe CS5/5.5 products is to create a package of the Adobe 
Provisioning Toolkit using Composer.

 
To create an Adobe Provisioning Toolkit package:

1. If you do not have the Adobe Provisioning Toolkit, download it from:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

2. Move the Adobe Provisioning Toolkit (adobe_prtk) to the following location:

/Library/Application Support/JAMF/

3. Open Composer and authenticate locally.

4. Drag the adobe_prtk binary file to the Sources list in Composer.
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5. When Composer is finished creating the package source, click the Build as DMG button.

6. When prompted, save the package in the desired location.

7. When Composer is finished building the package, quit the application.

 
Creating the Serialization Script(s)

Use the commands, tool syntax, and product identification information in “Using the Adobe 
Provisioning Toolkit Enterprise Edition” section of the CS5/5.5 Enterprise Deployment Guide to create 
a serialization script for each product. 

Each script must include the following information:

•	 The location of the adobe_prtk binary file

•	 Serialization commands

 
To create a serialization script:

1. Open a text editor.

2. From the menu bar, navigate to Format > Make Plain Text.

3. Enter the pathname to the adobe_prtk binary file followed by the serialization commands. For 
example, a script to serialize Adobe Photoshop® CS5/5.5 would look like this:

/Library/Application\ Support/JAMF/adobe_prtk --tool=ReplaceSN 
--serialize=Photoshop-CS5-Mac-GM --serial=XXXX-XXXX-XXXX-XXXX-
XXXX-XXXX

4. Save the script as a Bash Shell Script file with the .sh file extension.

5. Quit the application.
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Uploading the Adobe Provisioning Toolkit Package and 
the Serialization Script(s)
After creating the Adobe Provisioning Toolkit package and the serialization script(s), upload them 
to the JSS using Casper Admin.

 
To upload the Adobe Provisioning Toolkit package and the serialization script(s):

1. Open Casper Admin.

2. Log in using credentials for a JSS administrator account.

3. Drag the Adobe Provisioning Toolkit package and the serialization script(s) to the Package pane in 
Casper Admin.

The package may take a few minutes to upload depending on its size.

4. When the upload is complete, drag the package and script(s) into a category.

5. Double-click the serialization script.

6. In the Information pane that appears, click the Options tab.

7. Choose “After” from the Priority pop-up menu and then click OK.

8. Save your changes and quit the application.
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Creating a Policy to Serialize Adobe CS5/5.5 Products
Use the policy framework to install the Adobe Provisioning Toolkit package and run the 
serialization script(s) on target computers.

 
To create a policy to serialize Adobe CS5/5.5 products:

1. Log in to the JSS with a web browser.

2. Click the Management tab.

3. Click the Policies link.

4. Click the Create Policy button.

5. Select the Install or uninstall a package option and then click Continue.

6. Enter the name of the Adobe Provisioning Toolkit package and then click Continue.

7. Follow the onscreen instructions to complete the rest of the Policy Assistant.

Set the trigger as “every15” and the execution frequency as “Once per computer”.

You will add the script(s) using the manual policy interface in the next few steps.

8. On the Conclusion pane, verify that the name of the policy is correct and then click Edit Manually.

9. Click the Scripts tab.

10. Click the Add Script link.

11. Select the Run option next to each serialization script.

12. Click the Add Scripts button.

13. Click the Save button.

Computers in the scope execute the policy the next time they check in with the JSS.
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Reporting on Adobe CS5 or CS5.5 

After deploying Adobe CS5 or CS5.5, you can use the Casper Suite to track Adobe CS5/5.5 licenses 
and report on how often they are used. You can use this information to remediate clients that do 
not have Adobe CS5 or CS5.5 products installed and retrieve unused licenses.

Reporting on Adobe CS5/5.5 involves the following steps:

1. Create a licensed software record.

2. Update inventory in the JSS.

3. Generate a Licensed Software report.

4. Generate an Application Usage report.

5. Create a smart computer group.

 
Creating a Licensed Software Record 
Licensed software records allow you to store licensing information in the JSS. These records can 
include the number of licenses owned, serial number(s), and purchasing details.

Licensed software templates for Adobe CS5/5.5 are built right into the JSS, allowing you to create 
licensed software records quickly and easily.

Note: The licensed software template for Adobe CS5.5 is only available in the Casper Suite 8.21 
and later. 

 
To create a licensed software record:

1. Log in to the JSS using a web browser.

2. Click the Settings tab.

3. Click the Licensed Software Management link.

4. Click the Licensed Software from Template button.

18



5. Click the Create link across from the Adobe CS5/5.5 product.

6. Click the Licenses tab and click Add License.

7. In the Serial Number 1 and Serial Number 2 fields, enter serial number(s) for the product as 
needed.

8. Make sure that the Licenses For option is selected and enter the number of licenses in the 
Licenses field.

9. Click the Store License button.

10. Click the Software Definitions tab and verify that all products deployed in your licensed version of 
CS5 or CS5.5 are listed.
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11. Click the Save button.

 
Updating Inventory
The JSS must contain up-to-date inventory information to generate accurate reports. Although 
computers automatically submit updated inventory reports to the JSS according to the set 
frequency, you may want to generate inventory reports on the fly. You can do this using Casper
Remote.

 
To update inventory using Casper Remote:

1. Open Casper Remote.

2. Log in using credentials for a JSS administrator account.

3. On the Computers tab, select the checkbox next to each computer that has Adobe CS5/5.5 
products installed.

4. Click the Advanced tab.

5. Select the Update Inventory checkbox.
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6. Click the Go button to initiate the update.

7. When the update is complete, quit the application.

 
Generating a Licensed Software Report
Licensed Software reports allow you to view the following information about the licenses owned 
by your organization: 

•	 Number of licenses owned

•	 Number of licenses in use

•	 Computers that have the licenses installed

 
To generate a Licensed Software report:

1. Log in to the JSS with a web browser.

2. Click the Inventory tab.

3. Click the Licensing link above the search field.

4. Enter the name of the licensed software object in the search field.

5. Click the Search Licensing button, or type the Enter key.
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Generating an Application Usage Report
Application Usage reports go one step beyond license tracking by allowing you to view which 
licenses are being used. You can create a computer group based on the results of the report and 
use it to reclaim unused licenses.

 
To generate an Application Usage report:

1. Log in to the JSS with a web browser.

2. Click the Logs tab.

3. Click Application Usage logs.

4. Use the Reports Starting and Reports Ending pop-up menus to set a date range for the report.

5. Click the View Usage link across from the licensed software title for which you want to view full 
usage details.

 
To reclaim unused licenses:

1. Generate an Application Usage report as explained in the previous procedure.

2. After clicking the View Usage link, click the Unused Licenses tab.

This displays a list of computers that have unused licenses for the product.

3. Click the Create Computer Group button to create a group that contains these computers.

4. Create a policy to uninstall Adobe CS5 or CS5.5, and assign the group that you just created as the 
scope.

For detailed instructions on creating a policy to uninstall software, see the “Uninstalling Packages” 
section in the Casper Suite Administrator’s Guide.
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Creating a Smart Computer Group
Smart computer groups can be used to report on computers that have Adobe CS5/5.5 installed. 
They can also be used as the scope for CS5/5.5 update deployments. (For more information, see 
the “Deploying an Update-Only Package” section.)

Group membership is updated automatically when computers submit inventory reports to the JSS.

The following instructions explain how to create a smart computer group for computers that have 
Adobe CS5/5.5 installed.

 
To create a smart computer group:

1. Log in to the JSS with a web browser.

2. Click the Management tab.

3. Click the Smart Computer Groups link.

4. Click the Create Smart Group button.

5. Enter a name for the group, such as “Adobe CS5.5 Installed”.

6. In the list of categories, click the Add (+) button across from Software Information. 
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7. Click Licensed Software link in the list of items. 

8. Click the Ellipsis (...) button and then click the software title that you plan to update.

9. Click the Save button.
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Updating Adobe CS5 or CS5.5 

There are two ways to update Adobe CS5/5.5 products:

•	 Using an Adobe update server

•	 Using update-only packages

This section explains both methods.
 

Method 1: Deploying Updates Using an Adobe Update 
Server
Deploying updates using an Adobe update server allows users to manually install updates as they 
become available.

Note: Users must enter administrator credentials to install updates from the Adobe update 
server.

Implementing this method involves the following steps:

1. Set up an internal Adobe update server.

2. Generate a client configuration file.

3. Create a client configuration file package.

4. Upload the client configuration file package to the JSS.

5. Deploy the client configuration file package.

6. Verify that the Adobe update server is installed on client computers.

 
Setting Up an Internal Adobe Update Server

Follow the instructions in the “Setting Up an Update Server: At a Glance” section of the CS5/5.5 
Enterprise Deployment Guide to set up an internal Adobe update server.

 
Generating a Client Configuration File

Follow the instructions in the “Generating Client Configuration Files” section of the CS5/5.5 
Enterprise Deployment Guide to generate the client configuration file for the Adobe Application 
Manager Updater.
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Creating a Client Configuration File Package

Create a package of the client configuration file using Composer.

 
To create a client configuration file package:

1. Move the client configuration file that you just generated to the following location:

/Library/Application Support/Adobe/AAMUpdater/1.0/AdobeUpdater.
Overrides

2. Open Composer and authenticate locally.

3. Drag the client configuration file to the Sources list in Composer.

4. When Composer is finished creating the package source, click the Build as DMG button.

5. When prompted, save the package in the desired location.

6. When Composer is finished building the package, quit the application.

 
Uploading the Client Configuration File Package

After creating the client configuration file package, upload it to the JSS using Casper Admin.

 
To upload the client configuration file package:

1. Open Casper Admin.

2. Log in using credentials for a JSS administrator account.

3. Drag the client configuration file package to the Package pane in Casper Admin.

The package may take a few minutes to upload depending on its size.

4. When the upload is complete, drag the package into a category.
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5. Save your changes and quit the application.

 
Deploying the Client Configuration File Package

There are two ways to deploy the client configuration file package:

•	 Using a policy

•	 During imaging

 
To deploy the client configuration file package using a policy:

1. Log in to the JSS with a web browser.

2. Click the Management tab.

3. Click the Policies link.

4. Click the Create Policy button.

5. Select the Install or uninstall a package option and then click Continue.

6. Follow the onscreen instructions to configure the rest of the policy. 

Set the trigger as “every15” and the execution frequency as “Once per computer”.

Computers in the scope execute the policy the next time they check in with the JSS.

 
To deploy the client configuration file package during imaging:

1. Open Casper Admin.  

2. Log in using credentials for a JSS administrator account.

3. Double-click the client configuration file package in the Package pane.

4. In the Information pane that appears, click the Options tab.

5. Select the This package must be installed to the boot volume at imaging time checkbox and 
click OK.

6. Drag the client configuration file package from the Package pane to a configuration in the sidebar.

7. Save your changes and quit the application.

The client configuration file package is deployed the next time you use the configuration to image 
computers.

 
Verifying the Adobe Update Server on the Client Computers

To verify that the Adobe update server is installed on client computers, create an extension 
attribute that collects the IP address of the server. This also allows you to ensure that the IP address 
of the server is correct.
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To create an extension attribute that collects the IP address of the Adobe update server:

1. Log in to the JSS with a web browser.

2. Click the Settings tab.

3. Click the Inventory Options link.

4. Click the Inventory Collection Preferences link.

5. Click the Extension Attributes tab.

6. Click the Add Extension Attribute link.

7. Enter a name for the extension attribute, such as “Adobe Update Server”.

8. Choose “Populated by Script” from the Input Type pop-up menu.

9. Copy the following commands into the Mac OS X Script Contents field:

#!/bin/sh
updaterConfigFile="/Library/Application Support/ Adobe/

AAMUpdater/1.0/AdobeUpdater.Overrides" 

if [ -f "$updaterConfigFile" ];
then result=`/bin/cat "$updaterConfigFile" | grep -m 1 "Domain" | sed 

-e 's/<[^>]*>//g' sed 's:http\://::g' | awk '{print $1}'`
echo "<result>$result</result>"
else echo "<result>No Adobe Update Server Set</result>" 
fi'

10. Click OK and then click the Save button.

Client computers scan for and return the IP address of the Adobe update server the next time they 
submit inventory to the JSS.

 
Method 2: Deploying Update-Only Packages
Adobe makes CS5/5.5 updates available from their website at:

http://www.adobe.com/downloads/updates/

Downloading these updates and deploying them in package format allows you to update Adobe 
CS5/5.5 products without requiring users to install the updates themselves.

The AAMEE tool allows you to create an update-only package that contains multiple Adobe 
CS5/5.5 updates. You can deploy the update-only package using a policy or during imaging.

Deploying an update-only package involves the following steps:

1. Create an update-only package.
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2. Upload the update-only package to the JSS.

3. Deploy the update-only package.

 
Creating an Update-Only Package

Follow the instructions in the “Creating an Update-Only Package” section of the CS5/5.5 Enterprise 
Deployment Guide to create the package.

 
Uploading the Update-Only Package

After creating the update-only package, upload it to the JSS using Casper Admin.

 
To upload the update-only package:

1. Open Casper Admin.

2. Log in using credentials for a JSS administrator account.

3. Drag the update-only package to the Package pane in Casper Admin.

The package may take a few minutes to upload depending on its size.

4. In the Information pane that appears, click the Options tab.

5. Choose a priority from the Priority pop-up menu.

A priority of 11 is recommended for update-only packages. For more information on priorities, see 
the “Managing Packages” section in the Casper Suite Administrator’s Guide.

6. Configure additional settings as needed and then click OK.

7. Save your changes and quit the application.

 
Deploying the Update-Only Package

There are three ways to deploy the update-only package:

•	 Using a policy

•	 During imaging

•	 Using Self Service

This guide includes instructions for the first two methods. For instructions on the Self 
Service method, see the “Making Policies Available in Self Service” section of the Casper Suite 
Administrator’s Guide.

 
To deploy the update-only package using a policy:

1. Log in to the JSS with a web browser.
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2. (Optional) Create a smart computer group that can be used as the scope for the update 
deployment.

For more information, see the “Creating a Smart Computer Group” section.

3. Click the Management tab.

4. Click the Policies link.

5. Click the Create Policy button.

6. Select the Install or uninstall a package option and then click Continue.

7. Follow the onscreen instructions to configure the rest of the policy. 

Set the trigger as “every15” and the execution frequency as “Once per computer”.

Computers in the scope execute the policy the next time they check in with the JSS.

 
To deploy the update-only package during imaging:

1. Open Casper Admin.  

2. Log in using credentials for a JSS administrator account.

3. Double-click the update-only package in the Package pane.

4. In the Information pane that appears, click the Options tab.

5. Select the This package must be installed to the boot volume at imaging time checkbox.

6. Configure additional options as needed and click OK.

7. Drag the update-only package from the Package pane to a configuration in the sidebar.

8. Save your changes and quit the application.

The update-only package is deployed the next time you use the configuration to image 
computers. 
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